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KATA PENGANTAR 
 
 

Pertukaran informasi merupakan kebutuhan masyarakat modern, sehingga Teknologi 
Informasi dan Komunikasi (TIK) menjadi hal yang sangat penting. Secara kasat mata, 
setiap orang dapat menyaksikan perkembangan TIK yang sangat pesat. Perkembangan 
TIK sampai saat ini masih didominasi oleh negara-negara maju. Kondisi ini harus 
direposisi.  
 
Indonesia memiliki sumber daya manusia yang handal dan banyak, di antaranya berada 
di perguruan tinggi.  Sumber daya manusia ini terkesan bekerja masih sendiri-sendiri.  
Penelitian di lingkungan perguruan tinggi maupun litbang sering disalahartikan sebagai 
pemuas akademis, sementara di kalangan industri lebih tertarik pada penyelesaian 
ekonomis jangka pendek.  Permasalahan ini dapat diatasi dengan memulai kolaborasi 
antara dunia pendidikan, litbang, industri dan pemerintah. 
 
KOMMIT merupakan seminar nasional di bidang komputer dan teknik yang 
mendukung pengembangan teknologi komputer maupun aplikasi komputer dalam 
berbagai bidang. Seminar ini bertujuan menyediakan wadah bagi peneliti, akademisi 
dan praktisi untuk saling bertukar informasi, berdiskusi dan berkolaborasi sehingga 
dapat menghasilkan produk siap pakai di dalam bidang sistem informasi.  
 
Topik yang menjadi pembahasan pada KOMMIT ke 7 ini adalah: sistem informasi 
manajemen, sistem informasi geografis, sistem informasi medis, enterprise resource 
planning, information retrieval, matematika aplikasi, sistem keamanan, aplikasi 
multimedia, pengolahan sinyal dan citra, computer vision, open source & open content, 
e-government, e-business, e-education, data semantik, information system 
interoperability, distributed, parallel, grid, P2Pp, mobile information management, 
mobile tecnology, green computing, telekomunikasi dan jaringan komputer, sistem 
kontrol, instrumentasi dan diagnosis, mekanika dan elektronika, energi terbarukan, 
cognitive science, soft computing, perceptual science, bioinformatika dan 
geoinformatika, collaborative network, dan electron devices. 
 
Artikel yang disajikan pada seminar ini setelah melalui proses peer review, berjumlah 
seratus satu, yang berasal dari 15 Perguruan Tinggi di Indonesia.  Beberapa artikel yang 
terpilih akan di publikasikan pada Jurnal Ilmiah yang diterbitkan oleh Universitas 
Gunadarma.  
 
Semoga seminar ini dapat memberikan masukan bagi pengembangan teknologi 
informasi dan komunikasi di negara kita. Kami ucapkan terima kasih kepada para 
reviewer yang telah bersedia melakukan review, juga kepada pembicara tamu dan nara 
sumber yang telah berkontribusi pada acara ini, serta kepada semua pihak yang telah 
membantu proses produksi prosiding ini.   
 
 
 
Ketua Pelaksana 
Dr. Ir. Hotniar Siringoringo, MSc. 
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Abstrak 
 

Aplikasi pendidikan berbasis multimedia yang ditujukan bagi anak di bawah umur 7 
tahun, yang terdiri dari enam modul belajar yaitu modul mencocokkan gambar, 
mewarnai gambar, mencari pasangan gambar, aritmatika, mencari jalan keluar, dan 
modul belajar bahasa inggris. Selain itu ini berguna untuk lebih mengenalkan 
teknologi komputer secara visual dan interaktif kepada anak dibawah umur 7 tahun 
dan untuk membantu mereka mengetahui atau mengenal tentang komputer. 
 
Kata Kunci: pendidikan, aplikasi berbasis multimedia, Macromedia Flash MX 
 

PENDAHULUAN 
 

Dewasa ini perkembangan teknologi 
pada era globalisasi sangatlah cepat dan 
terkadang sulit diikuti. Hal ini menyebab-
kan manusia selalu berusaha untuk meng-
ikuti perkembangan teknologi tersebut. 
Hampir setiap manusia mempunyai ber-
bagai macam cara untuk mendapatkan 
informasi yang dibutuhkannya, baik itu 
dari membaca buku, koran ataupun media 
informasi lainnya. Meski demikian pada 
umumnya manusia mencari informasi 
dari media yang paling mudah untuk 
dipahami dan menarik untuk dilihatnya.  

Komputer sebagai salah satu hasil 
perkembangan teknologi, dapat menjadi 
suatu unsur penting pada kehidupan 
manusia modern saat ini. Banyak infor-
masi yang didapatkan dengan mudah 
melalui media komputer. Informasi terse-
but biasanya disajikan dalam bentuk mul-
timedia. Salah satu contohnya menyam-
paikan informasi kepada anak berumur di 
bawah 7 tahun, yaitu dengan cara mem-
bimbing anak tersebut untuk lebih inter-
aktif dengan teknologi dan membuat anak 
tersebut menjadi nyaman dan tidak asing 
dalam dunia teknologi. Bukan hanya 

orang dewasa saja yang harus mengenal 
dunia teknologi, tapi dari sedini mungkin 
teknologi itu harus diperkenalkan kepada 
anak-anak, agar anak di bawah umur 7 
tahun ini dapat lebih mengenal pendi-
dikan dengan menggunakan komputer 
dengan di dampingi atau dibimbing oleh 
kedua orangtuanya.  

Karena sangat pentingnya pendidik-
an anak di bawah umur 7 tahun maka pe-
nulis ingin membuat suatu bentuk 
penyajian informasi yang menggambar-
kan tentang aplikasi pendukung bagi anak 
dibawah umur 7 tahun dengan menggu-
nakan Macromedia Flash MX, karena 
software ini sangat interaktif dan mudah 
untuk dimengerti, terutama dalam pem-
butan animasi. 

Tujuan dari aplikasi pendidikan 
untuk anak di bawah umur 7 tahun yang 
berbasis multimedia  ini ialah untuk lebih 
mengenalkan teknologi komputer secara 
visual dan interaktif kepada anak dibawah 
umur 7 tahun; untuk membantu anak di 
bawah umur 7 tahun untuk lebih menge-
tahui atau mengenal tentang komputer; 
menyediakan interface standar untuk 
anak di bawah umur 7 tahun untuk meng-
gunakan berbagai media secara visual; 

586  Helmi dkk, Aplikasi Pendidikan Bagi... 



Prosiding Seminar Ilmiah Nasional Komputer dan Sistem Intelijen (KOMMIT 2012)                   Vol. 7 September 2012 
Universitas Gunadarma – Depok 18 – 19 September 2012                                                                 ISSN : 2302-3740 

dan memberikan efektifitas dan efisiensi 
kepada orang tua dan anak dibawah umur 
7 tahun untuk mendapatkan informasi 
mengenai aplikasi pendidikan berbasis 
multimedia tanpa harus datang langsung 
ke sekolah ataupun perpustakaan umum 
atau multimedia. 

 

METODE PENELITIAN 
      
Metode penelitian yang penulis 

gunakan ialah metode yang dilakukan 
dengan mencari literatur dan referensi 
dari buku-buku yang relevan, untuk lebih 
mendukung dan melengkapi teori yang 
berkaitan dengan aplikasi pendidikan ber-
basis multimedia  ini. 
 
 

 
 

Gambar 1. Struktur Navigasi Komposit 
 
Penjelasan mengenai struktur navigasi: 

A. Tombol beruang : untuk menuju halaman mencocokkan gambar 
B. Tombol kambing : untuk menuju halaman mewarnai gambar 
C. Tombol anjing : untuk menuju halaman aritmatika 
D. Tombol domba : untuk menuju halaman mencari pasangan gambar 
E. Tombol kucing : untuk menuju halaman belajar bahasa Inggris 
F. Tombol kupu-kupu : untuk menuju halaman mencari jalan keluar ( maze ) 
G. Tombol Back : untuk kembali ke menu utama 
X. Tombol keluar : untuk keluar dari aplikasi 
 
1. Halaman Mencocokkan Gambar 
2. Halaman Mewarnai Gambar 
3. Halaman Aritmatika 
4. Halaman Mencari Pasangan Gambar 
5. Halaman Mencari Jalan Keluar ( maze ) 
6. Halaman Belajar Bahasa Inggris 

 
HASIL DAN PEMBAHASAN 

 
Pada aplikasi pendidikan ini diguna-

kan struktur navigasi komposit (cam-
puran) sesuai dengan storyboard yang 
digunakan. Gambar 1 menunjukkan 
struktur navigasi komposit. 

Pembuatan Halaman Menu Utama 
Dalam pembuatan halaman menu 

utama ini terdiri enam tombol atau 
button, cara pembuatannya adalah: 
Pertama pilih Menu Bar > Insert > New 
Symbol, dan pada kotak symbol proper-
ties tulis nama simbol gambar tersebut 
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dan behaviour jenis symbol yaitu movie 
clip, simbol tersebut akan berada pada 
library. Kemudian import gambar yang 
formatnya GIF agar gambar tersebut 
terlihat bergerak-gerak. Kemudian kem-
bali ke menu utama dan pilih Window > 
library dan drag movie klip tesebut ke 
dalam stage, kemudian pilih Menu Bar > 
Insert > New Symbol Pada kotak Symbol 
Properties tulis nama simbol yaitu “tom-
bol” dan behaviour jenis symbol yaitu 
tombol atau button. Simbol tersebut akan 
berada pada library. Kemudian simbol 
tersebut di edit untuk menghasilkan tom-
bol yang diinginkan berdasarkan keada-
annya, yaitu Up, Over, Down dan Hit. 

Simbol “tombol utama” diletakkan 
pada stage dan layer “tombol” sehingga 
membentuk keyframe pada keadaan Up. 
Kemudian kita kosongkan pada keadaan 
Up, Over, Down fungsinya agar tombol 
tidak terlihat ketika kita menekan tombol 
tersebut pada menu utama. Pada keadaan 
Hit keyframe berisi tampilan kotak. Sete-
lah itu kembali ke menu utama kemudian 
buka library, drag Button tersebut ke 
dalam menu utama 

Selain tombol juga terdapat animasi 
pada tampilan “menu utama” di sana 
terlihat beragam binatang dimana bila 
mouse didekatkan ke salah satu binatang 
tersebut akan muncul suatu keterangan 
tentang menu yang akan dipilih dan bila 
mouse dijauhkan dari binatang tersebut 
maka keterangan tersebut akan meng 
hilang. Animasi ini berjenis tweened 
animation.  

Cara membuatnya adalah pertama 
animasi keterangan tersebut harus dijadi-
kan sebagai simbol dan setiap binatang 
tersebut menempati layernya sendiri. 
Proses pengerjaan animasi ditampilan 
“menu” ini dikerjakan pada simbol Movie 
Clip, kemudian animasi keterangan 
ditampilan menu ini diletakkan di layer 
animasi dan membentuk keyframe awal 
lalu tentukan keyframe akhir dengan 
menekan F6. Di antara keyframe awal dan 
keyframe akhir dibuat animasi berjenis 

Motion Tween dengan memilih Menu Bar 
> Insert > Create Motion Tween. Lalu 
pilih keyframe akhir pada layer “animasi” 
dan pindahkan posisi keterangan tersebut 
ke arah atas dari posisi semula. Kemudian 
tentukan keyframe akhirnya lagi dan 
pindahkan lagi posisi keterangan ke 
posisi semula. Kemudian di antara 
keyframe awal dan keyframe akhir dibuat 
animasi berjenis Motion Tween. Kemu-
dian klik keterangan tersebut dan akan 
muncul panel properties dan klik tanda 
panah ke bawah pada color kemudian 
pilih alpha dan set alpha menjadi 0% 
akan menghasilkan keterangan tersebut 
tidak terlihat. Kemudian pilih keyframe 
akhir dan tentukan effect Alpha dan set 
100%. Akan membuat keterangan terse-
but terlihat. Ini akan menghasilkan tam-
pilan keterangan yang bergerak ke atas 
dan kembali lagi ke bawah. Ketika 
pertama kali bergerak ke atas tampilan 
tidak terlihat dan ketika sampai di atas 
tampilan akan terlihat dan ketika turun 
tampilan seakan–akan menghilang. 

 

 
 

Gambar 2. Edit Simbol Tombol 
 

Pembuatan Halaman Mencocokkan 
Gambar 

Dalam pembuatan halaman menco-
cokkan gambar ini terdiri dari dari tiga 
tombol dimana langkah–langkah pem-
buatannya adalah pada tombol yang ada 
di halaman ini sama halnya dengan 
pembuatan tombol pada halaman menu 
utama, hanya berbeda pada link tombol 
tersebut dan bentuk tombol. 

Di halaman ini terdapat file gambar 
atau background, cara pengambilan file 
gambar ini adalah dengan memilih File > 
import, lalu pilih gambar yang ingin di 
letakkan ke dalam stage. Selain itu di 
halaman ini juga terdapat gambar kotak. 
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Cara membuatnya adalah dengan memilih 
rectangel tool, tool ini berada di toolbox 
lalu klik kiri pada mouse dan tahan mouse 
tersebut kemudian buat kotak sesuai 
dengan yang kita inginkan. Kemudian 
untuk warnanya klik garis tersebut dan 
akan muncul panel properties dan pilih 
stroke color untuk warna garisnya dan fill 
color untuk warna didalam kotak 
tersebut. 
 
Pembuatan Halaman Mewarnai 
Gambar 

Dalam pembuatan halaman mewar-
nai gambar terdiri dari dua tombol di 
mana langkah–langkah pembuatannya 
pada tombol yang ada di halaman ini 
sama halnya dengan pembuatan tombol 
pada halaman menu utama, hanya ber-
beda pada link tombol tersebut dan ben-
tuk tombol. 

Pada halaman mewarnai gambar ini 
juga terdapat file gambar. Langkah– 
langkah pembuatannya sama seperti pada 
halaman mencocokkan gambar, hanya 
gambarnya saja yang berbeda. Selain itu 
dalam halaman ini terdapat gambar kotak 
cara membuatnya sama seperti pada 
halaman mencocokkan gambar. 

Pada halaman ini juga terdapat dela-
pan lingkaran dimana setiap lingkaran 
tersebut berisi warna yang berbeda-beda 
diantaranya warna merah, hitam, putih, 
kuning, biru, abu-abu, dan ungu. Cara 
membuatnya adalah dengan memilih oval 
tool yang berada di toolbox lalu klik kiri 
pada mouse dan tahan mouse tersebut 
kemudian buat lingkaran sesuai dengan 
yang kita inginkan. Setelah itu pilih 
Window > Color mixer, pilih warna yang 
kita inginkan dengan mengklik warna 
tersebut lalu klik ke dalam lingkaran 
maka warna lingkaran akan berubah 
sesuai dengan warna yang kita pilih tadi. 
 
Pembuatan Halaman Aritmatika 

Dalam pembuatan halaman ini 
terdiri dari tiga tombol di mana langkah-
langkah dalam pembuatan tombol di 

halaman ini sama dengan pada halaman 
menu utama, hanya berbeda pada link 
saja dan bentuk tombol tersebut. Di 
halaman ini terdapat file gambar atau 
background. Langkah – langkah pem-
buatannya sama seperti pada halaman 
mencocokkan gambar, hanya gambarnya 
saja yang berbeda.  

Selain itu terdapat tulisan soal dan 
jawaban, cara membuatnya tulisan soal 
adalah dengan mengklik text tool yang 
berada di tool box kemudian rubah format 
text tersebut menjadi dynamaic text 
maksudnya dynamic text adalah text ini 
bersifat dinamis dan bisa di kontrol. 
Sedangkan untuk kolom jawaban, terda-
pat angka–angka, caranya adalah sama 
seperti cara pembuatan kolom soal perbe-
daanya hanya dalam format text, format 
text tersebut di ganti menjadi static text. 
 
Pembuatan Halaman Mencari 
Pasangan Gambar 

Dalam halaman ini terdiri dari tiga 
tombol dimana langkah-langkah dalam 
pembuatan tombol di halaman ini sama 
dengan pada halaman menu utama, hanya 
berbeda pada link saja dan bentuk tombol 
tersebut. Di halaman ini juga terdapat 
enam kotak yang tiap kotaknya terdapat 
satu file gambar, langkah–langkah pem-
buatannya sama seperti pada halaman 
mencocokkan gambar, hanya gambarnya 
saja yang berbeda. 

Dalam permainan ini digunakan 
gambar-gambar yang berbeda. Langkah-
langkah pembuatannya adalah sebagai 
berikut: impor gambar yang kita inginkan 
kemudian letakan di salah satu kotak 
gambar tersebut. buat simbol “Movie 
Clip” baru dan berikan nama “frame”. 
kemudian buat kotak pada frame1 dan 
pada frame2 klik kanan pada mouse 
kemudian klik insert blank key frame. 
Setelah itu buatlah kotak dan didalamnya 
buat tanda checklist. Buat simbol “Movie 
Clip” baru dan berikan nama “blink”. 
Kemudian klik pada frame pertama dan 
pilih action kemudian masukkan script 
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berikut stop( );. Setelah itu pada frame 2 
buatlah kotak kemudian pada frame 5 
takan F5. Kemudian klik pada gambar 
kotak tersebut dan set alpha menjadi 0. 
Setelah itu pada frame 6 klik kanan dan 
pilih action kemudian masukkan script 
berikut ini gotoAndPlay( 2 );. Kemudian 
klik kanan antara frame 2 dan 5 dan pilih 
create motion tween. Langkah selanjut-
nya ialah membuat tombol yang nantinya 
akan diletakkan di atas gambar-gambar 
yang dipilih, dibuat dengan cara buat 
simbol “tombol” yang baru beri nama 
“tombol_bantuan”. Pada area pengeditan 
simbol “tombol”, abaikan frame yang 
mempunyai label “Up”, “Over” dan 
“Down” kecuali pada frame “Hit” 
kemudian gambar kotak. Kemudian 
kembali ke stage utama dan buka library 
dengan Ctrl-L. Drag simbol frame, blink, 
tombol_bantuan ke dalam stage utama. 
 
Penggabungan Elemen Multimedia 

Elemen-elemen multimedia yang 
telah dibuat sebelumnya digabungkan 
pada Macromedia Flash 5.0. Halaman-
halaman yang dibuat mempunyai ukuran 
800 x 600 pixels. Tiap-tiap elemen 
diletakkan pada halaman utama (stage) 
dalam layernya sendiri. Setiap layer 
mendefinisikan objek-objek tersendiri. 
Letak elemen disesuaikan dengan 
tampilan halaman web yang dirancang. 
 
Pengoperasian 

Pertama klik file index.exe atau 
index.html maka program langsung 
menuju ke halaman utama dan 
menampilkan 6 gambar binatang yaitu 
“kambing”, “domba”, “kupu-kupu”, 
“anjing”, “beruang”, dan “kucing”. Gam-
bar “beruang” akan membuka halaman 
mencocokkan gambar yang mempunyai 
tiga tombol utama yaitu tombol ”back“, 
“next”, dan tombol “exit”, tombol “next” 
untuk melanjutkan ke gambar berikutnya 
sedangkan tombol “back” untuk kembali 
ke gambar sebelumnya dan tombol “exit” 
untuk kembali ke menu utama. Gambar 

“kambing” akan membuka halaman 
mewarnai gambar yang terdiri dari tiga 
tombol utama yaitu tombol “next“, 
“back”, dan tombol “exit” tombol 
“next” untuk melanjutkan ke gambar 
berikutnya sedangkan tombol ”back” 
untuk kembali ke gambar sebelumnya 
dan tombol “exit” untuk kembali ke 
menu utama. Gambar “kupu-kupu” akan 
membuka halaman maze yang mem-
punyai tiga tombol utama yaitu tombol 
“next“, “back”, dan tombol “exit” 
tombol “next” untuk melanjutkan ke 
maze berikutnya sedangkan tombol 
”back” untuk kembali ke maze sebe-
lumnya dan tombol “exit” untuk kembali 
ke menu utama. Gambar anjing akan 
membuka halaman aritmatika dimana 
terdapat tiga tombol utama yaitu tombol 
“next“, “back”, dan tombol “exit” 
tombol “next” untuk melanjutkan ke soal 
berikutnya sedangkan tombol ”back” 
untuk kembali ke soal sebelumnya dan 
tombol “exit” untuk kembali ke menu 
utama.  

Gambar domba akan membuka 
halaman mencari pasangan gambar 
dimana terdapat tiga tombol utama yaitu 
tombol “next“, “back”, dan tombol 
“exit” tombol “next” untuk melanjutkan 
ke gambar berikutnya sedangkan tombol 
”back” untuk kembali ke gambar sebe-
lumnya dan tombol “exit” untuk kembali 
ke menu utama. Gambar kucing akan 
membuka halaman belajar bahasa Inggris 
dimana terdapat tiga tombol yaitu yaitu 
tombol “next”, “back”, dan tombol 
“exit”, tombol “next” untuk melanjutkan 
ke soal berikutnnya sedangkan tombol 
“back” untuk kembali ke soal sebelum-
nya dan tombol “exit” untuk kembali ke 
menu utama. Dan di halaman menu uta-
ma juga terdapat tombol untuk kelur dari 
aplikasi ini. 
 
SIMPULAN  

 
Berdasarkan pembahasan pada Bab 

sebelumnya dapat disimpulkan bahwa 
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“Modul Aplikasi Pendidikan Bagi Anak 
Di Bawah Umur 7 Tahun” dengan meng-
gunakan Macromedia Flash MX cukup 
baik. Meskipun tampilan yang dihasilkan 
masih sangat sederhana, namun peran-
cangan alur navigasi aplikasi ini sudah 
cukup jelas.  

Kurangnya informasi yang diper-
lukan membuat penulis mengalami sedi-
kit kesulitan dalam pembuatan aplikasi 
ini. Pemakai aplikasi ini dihadapkan pada 
tampilan-tampilan sederhana dengan 
menu-menu yang tidak terlalu rumit, 
sehingga pemakai aplikasi ini dapat 
memperoleh suatu pengetahuan dan 
manfaat dari aplikasi ini.  
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